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File Fundamentals

Top 15 File Management Tips

hen you sit down to use
your computer, chances are
you'll spend some of your
time locating, copying, delet-
ing, and otherwise organiz-
ing your files. To do so, you'll use Windows
XP’s basic file management tools: Windows
Explorer, My Computer, and the Search
Companion. Although using these tools to
manage your files is pretty straightforward,
there are a number of tricks you can use to
make quick work of your file management
tasks. You can even customize
certain features to make them
easier to use. Here are 15 tips
that will help you get the most
out of WinXP’s file manage-
ment tools.

Simultaneously rename

multiple files. When you
work with groups of similarly-
named files, chances are good
you'll eventually want to rename
all the files. For example, if your
digital camera saves picture files
using a sequential naming scheme
such as PIC263.JPG, PIC264.JPG, and
s0 on, you'll probably want to rename
them with more meaningful names after
you transfer them to your computer.
Fortunately, WinXP lets you simultaneously
rename groups of files.

To begin, select the group of files you want
to rename; right-click on the first file in the
group and select Rename. Then, type the new
name along with the number 1 in parenthesis.
For example, you might rename this first file
Birthday (1).JPG. When you press ENTER,
each of the selected files will be renamed with
the new name and the number in the parenthe-
ses will be incremented sequentially. In this
case, the result would be Birthday (1).JPG,
Birthday (2).JPG and so on.

Use the Move This and Copy This
commands. If you regularly move or
copy files and folders on your hard disk, you'll
definitely want to get into the habit of using

the Move This and Copy This commands, as
they can be real timesavers. When you open
any folder in Windows Explorer and then
select a file or a folder, you'll see the Move
This and Copy This commands in the File and
Folder Tasks section of the new task-oriented
Explorer Bar. (If you select a file, the command
will be called Copy This File. If you select a

folder, the command will instead be called
Copy This Folder.)

When you use the Move This or Copy This
commands, you'll see a browse dialog box and
can easily select a destination. You can even
create a new folder for the destination by click-
ing the Make New Folder button.

If you prefer, you can add these handy file
management features to the toolbar. To do so,
right-click the toolbar, select Customize, and
use the controls in the Customize Toolbar
dialog box to add the Move To and Copy To
buttons to the toolbar.
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Having difficulty traversing a tightly nested
folder tree in the Browse dialog box? No prob-
lem. Just position your pointer over the handy
resize pad in the bottom-right corner; when
you see a double-headed arrow, you can drag
to make the Browse dialog box larger.

Uncover the Make A New Folder
command. As you know, when you
open a folder in Windows Explorer, you can
create a new subfolder by pulling down the
File menu and selecting New, then Folder, or
by right-clicking inside the folder %nd
g selecting New, then Folder from the
5 context menu. However, WinXP pro-
vides you with a new and even
faster way to create new folders.
When you first open a folder
in Windows Explorer, you'll
find that the File And Folder
Tasks section of the new task-
oriented Explorer Bar already
contains the Make A New
Folder command. However,
as soon as you select any file
or folder, the list in the File
And Folder Tasks section
. changes to show you other com-
mands related to managing
existing files and folders and the
Make A New Folder command
gets hidden from view. This is
too-bad, because it's already
easy to forget this command;
hiding it makes it that much easier to forget.
Fortunately, you can easily uncover the
Make A New Folder command by clicking
anywhere in the folder to clear the currently
selected item. As soon as you do, the File and
Folder Tasks section will again display the
Make A New Folder command. You can then
effortlessly create a new folder with one click.

Gain access to Full Screen view in
Windows Explorer. If you need more
room to work in Windows Explorer, chances are
you click the Maximize button to expand the
window. However, you can get even more
workspace by activating the hidden Full Screen
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feature (similar to the one in
Internet Explorer) by pressing F11.

Show In

confidential files with pass-
words. After you create a com-

If the task-oriented Explorer Bar is pressed folder and add files to it,
enabled when you activate the Gri oups adds open the folder, pull down the
Full Screen view, it will remain in File menu, and select Add A
the window. However, if youre @ Wh0/e Password. When you enter a
using any of the other Explorer password, WinXP assigns that
Bars, such as Folders or Search, W password to every file currently
when you activate Full Screen in the compressed folder.

view and then click anywhere in : : Once you've password-pro-
tll\e window, the Explon)errw Bar will dimension tected yg,ur comgressed folF:ier,
slide out of view giving you even you can double-click on the
more réom to work. To bring the [0 fhe way compressed folder and open it
Explorer Bar back into view, just just as you could before.
move your mouse over the left you can However, when you attempt to

edge of the screen. To return the
screen to normal size, simply press

look at

access any file in the compressed
folder, you'll be required to enter

F11 again. the password.

If you need to access the tool- i It's important to keep in mind
bar, just move your mouse over  YOUF files. that if you add other files to a
the top of the screen and the tool- password-protected compressed
bar will drop down. folder at a later date, those files

Take advantage of the Show In
Groups feature. When you launch
Windows Explorer, you can display files using
one of WinXP’s five default views: Tiles, Icons,
List, Details, or Thumbnails. To alternate
ameng these views, you can click the Views

button on the toolbar or pull down the View.

menu. If you use the View menu, you can fur-
ther organize the display by selecting one of
the four sort options on the Arrange Icons By
submenu: Name, Size, Type, or Modified. If
you're using any of the default views other
than List (a minor bug in WinXP), you'll find a

- new sort option on the Arrange Icons By sub-
menu called Show In Groups, which adds a
whole new dimension to the way you can look
at your files.

When you select the Show In Groups
option, the Windows Explorer display will be
divided into sections with headers that corre-
spond to the sort option you've selected. Your
files will then be organized under these head-
ings accordingly. For example, if you're using
the Name sort option, you'll see alphabetic
headers A, B, C, and so on, and your files will
be grouped under the appropriate headers. If
you're using the Details view, you can change
the Show In Groups option simply by clicking
on the various column headers.

Password-protect files stored in
compressed folders. In addition to
conserving hard drive space, the Compressed
Folders feature offers you the ability to protect
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won't automatically be password-
protected. In order to password-protect new
files, you'll need to first remove the existing
password and then reapply it. To do so, pull
down the File menu and select Remove
Password. You'll then be prompted for the
password. Once the pass-
word has been removed,
you can use the Add A
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back and forth between the two as your search
needs change. You can do so by creating a cou-
ple of Registry (REG) files. (Remember,
though, that tweaking the Windows Registry
is dangerous. Be sure to see “Protect Yourself,”
beginning on page 32, for information about
how to back up the Registry before making
this or any other change to the Registry.)

To begin, launch the Registry Editor by
accessing the Run dialog box, which you can
do quickly with the Windows-R shortcut, and
typing regedit in the Open text box. After you
see the Registry Editor, follow the path to the
CabinetState key: Go to HKEY_CURRENT
_USER, Software, Microsoft, Windows,
CurrentVersion, Explorer, then CabinetState

Once you open the CabinetState key, right-
click inside the key and select New, String,
then Value. When the value appears in the
key, name it Use Search Asst, press ENTER
twice, type no (all lowercase) in the Value Data
text box, and click OK. Now, right-click the
CabinetState key and select Export. In the
Export Registry File dialog box, type Disable
Search Companion in the File Name text box,
make sure the Selected Branch option button is
selected, and click the Save button. Then close
the Registry Editor.

Password feature to reap-

ply the password to all
the files in the com-
pressed folder.

Roll back the

WinXP Search
Companion. WinXP’s
Search Companion comes
with a host of new bells
and whistles, including an
animated character that
occasionally offers sug-
gestions, and a number of
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Tip 1. WinXP’s Rename function lets you simultaneously rename
multiple files in one simple operation.

options that let you fine-
tune your search. Although these additional
features are generally helpful, there are times
when a basic search interface, such as the one
found in Windows Me and 2000, is all you
really need.

Fortunately, the basic Search interface is still
there, buried beneath WinXP’s new Search
Companion, and you can uncover it with
slight registry tweak. However, rather than
abandoning the Search Companion altogether,
you might find it useful to be able to switch

At this point, open the Disable Search
Companion.reg file in Notepad, locate the line
“Use Search Asst”="no” and change the value
inside the quotes to yes. (Again, be sure to use
all lowercase letters.) Save the file as Enable
Search Companion.reg.

You can now switch between the Search
Companion and Search simply by double-
clicking the appropriate file. The changes these
files make are instantaneous, so there’s no
need to reboot.



Keep in mind that when you double-click
either of these files, the Registry Editor dis-
plays two dialog boxes: One prompts you to
confirm the operation and the other lets you
know the operation was successful.

Add a New Folder button to the

Quick Launch toolbar. If you want a
quick and easy way to create new folders,
you can add a New Folder button to the
Quick Launch toolbar. To do so, launch
Windows Explorer and open the
C:\Documents and Settings\ Username
\Application Data\Microsoft\Internet
Explorer\Quick Launch folder, where
Username is the name assigned to your
account on the system. Once you open the
Quick Launch folder, create a new folder
inside of the Quick Launch folder and leave
it named New Folder. At this point, you'll see
a new icon on your Quick Launch toolbar,
entitled New Folder. (You may have to expand
the Quick Launch toolbar.)

Now, whenever you want to create a new
folder, just hold down the CTRL key as you
drag and drop the New Folder icon wherever
you want to create the new folder.

Customize Windows Explorer’s

Details view. When you use Windows
Explorer’s Details view to display your files,
the column headers can come in real handy as
you're analyzing and managing your files.
Fortunately, WinXP provides you with the
ability to add, remove, and rearrange the vari-
ous column headers to better

In addition to accessing the Choose Details
dialog box, you can add and remove column
headers by right-clicking on any header to dis-
play the Choose Details context menu and
then selecting a header name from the list—a
check mark indicates which headers are
currently in use. If you like, you can also

i
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Tip 4. Using WnXP's Full Screen view in Windows
Explorer gives you more room to work.

rearrange the headers by selecting a header
and dragging it to the right or the left.
1 Add and remove shared docu-
ments from My Computer. When
you open My Computer, you'll notice that the
display includes all the Shared Documents
folders on the system. Although the Shared
Documents feature is designed to make it easy
for you to share files with other users on the
same system, the presence of these Shared
Documents folders in My Computer can be
distracting when you're performing file man-
agement operations. If you'd like to be able to

turn the Shared Documents folders display on
and off, you can do so by creating a couple of

Sysom e

REG files. (Again, tweaking the Windows
Registry is dangerous, so be sure to see
“Protect Yourself,” beginning on page 32, for
information about how to back up the Registry
before changing anything.)

To begin, launch the Registry Editor by
accessing the Run dialog box (you can use
either the Start menu or the Windows-R short-

cut) and typing regedit in the Open text

box. Then, follow the path to the

DelegateFolders key: Go to HKEY_LOCAL

_MACHINE, SOFTWARE, Microsoft,

Windows, CurrentVersion, Explorer, My

Computer, NameSpace, DelegateFolders.

Once you open the DelegateFolders key,
right-click the subkey entitled {59031a47-
3f72-44a7-89¢5-5595fe6b30ee} and select

Export. In the Export Registry File dialog

box, type Add Shared Documents in the
File Name text box; make sure the Selected
Branch option button is selected in the Export
Range panel, and click the Save button. Close
the Registry Editor.

Now, locate the Add Shared Documents.reg
file, open it in Notepad, and add a minus sign
(-) to the beginning of the key name, right
inside the square brackets. Then, save the file
as Remove Shared Documents.reg.

Now, when you want to remove the Shared
Documents folders from My Computer, you
can just double-click the Remove Shared
Documents.reg file. If you later want to replace
the Shared Documents folders in My
Computer, double-click the Add Shared
Documents.reg file. The changes these REG

files make are instantaneous,

fit your needs. so there’s no need to reboot.
To do 50, pull down the ' [E ea e rans v et Again, keep in mind that
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Choose Details dialog box, | e Ty ‘ e Registry Editor displays two
you'll find that you can add s ceikiidids D et HaNE T dialog boxes—one prompts
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by selecting or clearing the
checkboxes. You can also select
a detail and click the Show and
Hide buttons. Furthermore,
you can change the order in
which the column headers
appear in the Details view by
selecting a detail and using the
Move Up or Move Down but-
tons. You can then specify how
wide a column should be by
selecting the detail and typing
a numeric value in the Width
Of Selected Column text box.

Tip 8. Adding a New Folder button to the Quick Launch toolbar provides a quick and
easy way to create new folders on your hard drive.

and the other lets you know
the operation was successful.
-l Use custom fold-

er icons. When
you're storing files in My
Documents, chances are you
create folders and use them
to keep your documents
organized by topic. When
you do so, you label each of
these folders with an appro-

priate name that will help
you to identify the contents.
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However, after a while you may discover that
you have so many folders that it's difficult to
quickly locate those folders you use most
often. Fortunately, WinXP lets you customize
each individual folder by changing its icon. By
doing so, you can make it easier to distinguish
those folders you use on a regular basis.

To get started, right-click
on the folder and select
Properties. When the folder’s
Properties dialog box
appears, select the Customize
tab. Then, click the Change
Icon button at the bottom of
the tab. You'll then see the familiar
Change Icon dialog box you can use
to select any icon you wish to assign

to the folder.
12 Configure the My
Computer icon to open
in Windows Explorer mode.
When you launch My Computer
from the Start menu, the default dis-
play opens using the new task-ori-
ented Explorer Bar. Although this
Explorer Bar provides you with
some very handy file management
features, more often than not, what

L

estate. If you look closely, you'll notice that
neither the Standard Buttons toolbar nor the
Address Bar toolbar really use the full length
of the window. As such, more than half of each
of these toolbars can be considered wasted
space. Fortunately, you can combine these two
toolbars to easily reclaim this wasted space.

Tip 10. To create the Remove

the beginning of the key name.

Windows Explorer toolbar layouts will also
appear in IE, as they share the same basic
interface settings. Generally, you can’t change
one without changing the other.)
1 4 Put the file management tools
back on the desktop. Ever wish
that the WinXP desktop
included the My Computer,

windows Registry Editor version 5.00 . Shared m-l‘!"‘u My Documents, and My
E;mmmnxu\mw crosoft\windows\Currenty simply add a minus sign (-) to Network Places icons, like
the previous versions of

Windows did? If so, you'll
be glad to know you can
easily put them back. To do so,
right-click the Desktop and select

Properties. When the Display

Properties dialog box appears,
select the Desktop tab, and click
the Customize Desktop button.
When you see the Desktop Items
dialog box, just select the appropri-
ate checkboxes in the Desktop

Icons panel.
Don’t forget to investi-

Tip 13. Customizing the toolbar layout enables you to make much more
efficient use of the available space.

1 gate the Advanced
Settings feature. If you want to
explore other ways you can you can

you really need access to when you
launch My Computer is the Folders Explorer
Bar. Of course, you can always click the
Folders button after you open My Computer,
but wouldn't it be more convenient to have
My Computer open in Windows Explorer
mode by default? Fortunately, you can easily
configure My Computer to do so.

Launch My Computer, pull down the Tools
menu, and select Folder Options. When you
see the Folder Options dialog box, select the
File Types tab. In the Registered File Types
pane, select the icon entitled (NONE) Folder,
and click the Advanced button near the bot-
tom of the dialog box. When you see the Edit
File Type dialog box, select Explore from the
Actions list, and click the Set Default button.
To complete the operation, click OK to close
the Edit File Type dialog box and then click
Close to exit the Folder Options dialog box.

1 Rearrange the My Computer

and Windows Explorer toolbar
layout. By default, the My Computer and
Windows Explorer toolbar layout consists of
three toolbars stacked on top of each other.
Although all these toolbars are necessary, this
layout wastes a lot of valuable screen real
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To begin, you'll need to unlock the toolbars
by right-clicking any one of the toolbars and
deselecting Lock The Toolbars to disable it. As
soon as you do, you'll notice that handles
appear at the left edge of each of the toolbars.
Now, click on the Address Bar toolbar’s han-
dle, drag it to the center of the Standard
Buttons toolbar, and position it just to the right
of the Help menu. When you release the
mouse button, the Address Bar and Standard
Buttons toolbars basically merge to become
one toolbar that actually uses the full length of
the window.

You can clean up the toolbar layout even
more by reducing the amount of space that the
Standard Buttons toolbar uses and removing
the Go button from the Address Bar toolbar.
To do so, right-click the Standard Buttons tool-
bar and select Customize. Then, in the

Customize Toolbar dialog box, select No Text

Labels and Small Icons; then click Close. Now,
right-click the Go button and deselect Go
Button to disable it.

To complete the operation, right-click on
any one of the toolbars and select Lock The
Toolbars to enable it. (Keep in mind that any
changes you make to the My Computer and

customize the My Computer and
Windows Explorer interface, you'll want to
take a look at the Advanced Settings feature.
To do so, pull down the Tools menu and select
Folder Options. When you see the Folder
Options dialog box, select the View tab. You
can then use the checkboxes and radio buttons
in the Advanced Settings list box to enable or
disable all kinds of settings. Although most of
the settings are self explanatory, some are a bit
cryptic. To learn more about any of these
advanced settings, click the question mark
icon in the title bar and then click the setting,
When you do, you'll see a pop-up box that
contains a detailed description of the setting.
If you make changes and then later want to
restore the original settings, just click the
Restore Defaults button.

# Knowing The Ins & Outs. There’s no way
around it: You're going to spend a lot of time
managing your files. Knowing the ins and outs
of WinXP’s file management tools will help
you make quick-work of arranging and keep-
ing track of the files on your hard drive. [i5]

by Greg Shultz



